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ВСТУП


Мета дисципліни «Гнучке управління проектами» − показати проектний підхід до розробки програмних засобів та навчити студентів використовувати на практиці основні методи, інструменті та засоби керування проектами.

Внаслідок виконання лабораторних робіт з дисципліни студенти повинні вміти: розробляти загальний план проекту, що вимагає значного об’єму робіт; ефективно оцінювати проектні витрати; вимірювати прогрес проекту, продуктивність та інші аспекти процесу розробки програмного забезпечення; використовувати метод засвоєного об’єму для аналізу вартості; динамічно регулювати плани проекту; використовувати засоби керування змінами та системи призначення задач в проектах з розробки програмного забезпечення.

Звіт з лабораторних робіт повинен містити змістовний аналіз отриманих результатів та висновки.

Під час співбесіди студент повинний виявити знання про мету роботи, по теоретичному матеріалу, про методи виконання кожного етапу роботи, по змісту основних розділів розробленого звіту з демонстрацією результатів на конкретних прикладах.

Студент повинний вміти правильно аналізувати отримані результати. Для самоперевірки при підготовці до виконання і здачі роботи студент повинний відповісти на контрольні питання, приведені наприкінці відповідної роботи.

Для виконання лабораторних робіт рекомендується використовувати безкоштовну систему керування проектами ProjectLibre чи OpenProj, або платний продукт Microsoft Project. Також можливе використання системи LibrePlan. Крім того студент за власним бажанням може використовувати будь-яку систему керування проектами, що підтримує необхідні можливості.

[bookmark: _heading=h.2et92p0]
Лабораторна робота № 1 
Створення проекту та календарне планування робіт

[bookmark: _heading=h.tyjcwt]1.1 Мета роботи

Одержання практичних навичок створення проекту і планування робіт із застосуванням програмного забезпечення по керуванню проектами.

[bookmark: _heading=h.3dy6vkm]1.2 Основні теоретичні положення та методика викладання роботи

ProjectLibre 1.5 [1] – це програмний пакет загального призначення для керування проектами. ProjectLibre дозволяє швидко спланувати проект, наочно представити його структуру, виявити "вузькі місця", випробувати різні сценарії й варіанти, одержати набір проектної документації, що відповідає загальноприйнятим світовим стандартам. При цьому ProjectLibre охоплює як управлінські функції («хто, коли й що повинен робити»), так і вартісні характеристики проекту.

На рис. 1.1 наведена екранна форма, яка ілюструє основні елементи інтерфейсу системи ProjectLibre.

[image: ]
Рисунок 1.1 – Інтерфейс системи

[bookmark: _heading=h.4d34og8]1.2.1 Створення нового проекту

Для створення нового проекту скористайтеся меню [File » New] (рис.1.2).

[image: ]
Рисунок 1.2 – Вікно створення нового проекту

· діалоговому вікні, що відкрилося, внесіть наступні дані:
– назву проекту,
– менеджера (ПІБ студента),
– дату початку (або дату закінчення) проекту,
– тип розкладу (при плануванні вперед потрібно вказати дату

початку, а при плануванні назад – дату закінчення проекту).

Більш детальну інформацію про проект можна внести за допомогою меню [File » Project » Information] (рис. 1.3).

[image: ]
Рисунок 1.3 – Вікно інформації про проект

У цьому ж діалоговому вікні на вкладці Статистика можна ознайомитися з поточною статистикою по відкритому проекту: вартість та тривалість проекту, поточний відсоток виконання тощо.

[bookmark: _heading=h.17dp8vu]1.2.2 Календар проекту

Календар (Calendar) – це інструмент формування розкладу проекту, що дозволяє встановлювати розподіл робочого й неробочого часу задач і ресурсів.

За допомогою меню [File » Project » Calendar] можна налаштувати робочі календарі для проекту (рис.1.4-1.5): задати час початку роботи, кількість робочих годин на день, тиждень та місяць, а також розклад змін при змінній роботі.
ProjectLibre надає три усталених календарі: стандартний календар (п'ятиденка), 24-годинний календар і календар з нічними змінами. Звичайно в якості базового використовується стандартний календар.
[image: ]
Рисунок 1.4 – Робочий календар проекту

[image: ]
Рисунок 1.5 – Налаштування тривалості робочого часу
[bookmark: _heading=h.26in1rg]1.2.3 Види

Види дозволяють розглядати проект із різних точок зору. В ProjectLibre існує дві основні категорії видів (вкладка [View] або пункти меню [Task] і [Resource]):

– вид задач;
– вид ресурсів.

· одному й тому самому вікні ProjectLibre можна виводити комбінації видів за допомогою пунктів у меню [View » Sub-views].

Усталеним видом проекту є Подання Ганта (рис.1.1).

[bookmark: _heading=h.lnxbz9]1.2.4 Задачі проекту

Планування задач проекту тією чи іншою мірою здійснюється в період усього строку виконання проекту. На самому початку життєвого циклу проекту звичайно розробляється неофіційний попередній план – грубе уявлення про те, що буде необхідно виконати у випадку реалізації проекту.

Рішення про вибір проекту значною мірою ґрунтується на оцінках попереднього плану. Формальне й детальне планування проекту починається після ухвалення рішення про його реалізацію. Визначаються ключові точки проекту, формулюються задачі і їх взаємозалежність.

Середовище ProjectLibre включає набір засобів для розробки плану проекту: таблицю для введення задач і діаграму Ганта [Task » Views » Gantt], графічне подання ієрархічної структури робіт [Task » Views» WBS], мережний графік [Task » Views» Network].

[bookmark: bookmark=id.35nkun2]Діаграма Ганта – це графічне подання всіх задач, які складають проект. Діаграма Ганта складається зі смуг, орієнтованих уздовж осі часу. Кожна смуга представляє окрему задачу (роботу) проекту, її кінці – моменти початку і завершення роботи, її довжина – тривалість роботи. Крім того на діаграмі можуть бути відзначені сукупні задачі, відсотки завершення, покажчики залежності робіт, віхи проекту, мітка теперішнього моменту часу тощо.

Задача (Task) у плані проекту передбачає якусь діяльність, яка необхідна для досягнення конкретних результатів (кінцевих продуктів нижнього рівня, deliverables). На виконання задачі необхідний час. Момент завершення задачі означає факт одержання кінцевого продукту, тобто результату виконання задачі.

Виділяють три основні типи задач.

Зведені або складені задачі (Summary task), що містять декілька підлеглих задач.

Підзадачі (Subtask) – невеликі задачі, що є частиною якихось більших задач.

Віхи (Milestone) – це задачі, у яких встановлена нульова тривалість і які позначають проміжні цілі проекту. Віха – ця подія або дата в ході виконання проекту. Вона використовується для відображення стану завершеності тих або інших задач. У контексті проекту менеджери використовують віхи для того, щоб позначити важливі проміжні результати, які повинні бути досягнуті в процесі реалізації проекту. Послідовність віх проекту називається планом по віхах. Важливою відмінністю віхи від задачі є те, що вона не має тривалості.

Організація задач проекту включає наступні дії.

Визначення задач – розбивка очікуваних результатів проекту на більш дрібні задачі, які легше піддаються обліку й керуванню.

Визначення послідовності задач – установлення залежності між задачами й визначення обмежень у властивостях задач.

Оцінка тривалості задач і проекту в цілому – оцінка часу, необхідного для завершення всіх задач проекту.

Для організації задач проекту в середовищі ProjectLibre необхідно перейти у подання Ганта.

Перший крок – створення начерку робіт (зведених задач), які необхідно виконати в проекті.

Для створення задачі в таблиці задач виберіть комірку Name і вкажіть назву задачі. Встановіть тривалість задачі або оцінку тривалості задачі (позначається знаком питання).

[bookmark: bookmark=id.1ksv4uv]При подвійному клацанні мишею на задачі або виборі меню [Task » Information] відкриється діалогове вікно Інформація про задачу (рис. 1.6). Тут можна додати більш докладний опис задачі, а також указати коментарі та посилання на відповідні документи.
Для створення віхи, укажіть назву й встановіть тривалість задачі в значення 0. Віхи в ProjectLibre на діаграмі Ганта представлені у вигляді ромбів, а не смужок. 
Перелік стовпців таблиці Задачі можна змінювати за необхідності, натиснувши праву кнопку мишки на заголовку й вибравши в контекстному меню пункт Вставити стовпець або Сховати стовпець. 
Для того щоб розділити задачу на частині (Split task) так, щоб частини можна було виконувати в різний час, або якщо буде потреба перервати задачу на час (відпустка або хвороба виконавця), натисніть праву кнопку миші на задачі в діаграмі Ганта й у спливаючому контекстному меню виберіть пункт [Split] (рис.1.7).

[image: ]
Рисунок 1.6 – Вікно інформації про задачу







[image: ]
Рисунок 1.7 – Поділ завдання

За замовчуванням в ProjectLibre використовується шкала тижнів

· днів для відображення діаграми Ганта. Якщо необхідно побачити укрупнену картину проекту, ви можете перемкнутися на шкалу місяців, років й кварталів і так далі. Для цього скористайтеся кнопками зміни масштабу виводу [Zoom In] і [Zoom Out] у режимі перегляду задач.

[bookmark: _heading=h.2jxsxqh]1.2.5 Структурування задач

Для структурної декомпозиції задач проекту після внесення зведених задач у таблицю необхідно додати підлеглі задачі й включити їх у зведені (рис. 1.1).

Інструмент структурування доступний у вигляді пунктів меню Відступ і Виступ або відповідно [Task » Indent] і [Task » Outdent].

Зведена задача вирівняна вліво, її назва виділена жирним шрифтом, і перед назвою розміщається кнопка [-], що означає Згорнути. Відповідні підлеглі задачі розташовані з відступом вправо щодо зведеної задачі.

Зверніть увагу, що будь-яка дія над зведеною задачею – видалення, переміщення або копіювання – застосовується також до всіх вкладених задач.

[bookmark: _heading=h.z337ya]1.2.6 Зв'язки між задачами, затримки й перекриття зв'язків

Зв'язки передування (логічні залежності, Link) між задачами відображають природу залежностей між ними. Більшість залежностей

· проектах відносяться до типу «Закінчення-Початок», при якому наступна задача може бути виконана тільки після завершення попередньої задачі.

Зв'язки передування утворюють мережну структуру проекту. Сукупність взаємозв'язків між задачами також називаються логічною структурою проекту, яка визначає послідовність виконання задач.

Для переходу до календарного планування необхідно визначити зв'язки передування між задачами проекту. Дати початку або завершення кожної задачі у середовищі ProjectLibre не встановлюються вручну, а визначаються автоматично після встановлення зв'язків між задачами.

[bookmark: bookmark=id.3j2qqm3]Задача, яка впливає на іншу задачу, називається Попередником (Predecessor), а задача, яка залежить від іншої задачі, називається Послідовником (Successor). Наприклад, задача «Програмування» є попередником для задачі «Тестування».

Задачі можуть бути зв'язані чотирма типами зв'язків, наведеними в таблиці 1.1. Іноді буває необхідно вказати запізнювання або випередження (Lag and Lead, затримка) в зв'язку між задачами. Затримки можуть бути зазначені в одиницях часу або у відсотках від тривалості задачі-попередника. При цьому позитивна затримка вкаже запізнювання, а негативна – випередження.

Приміром, між задачами «Програмування» і «Тестування» повинен пройти один тиждень, щоб з'явився код для тестування. У випадку завдання затримки у відсотках, якщо попередня задача триває 4 дня, затримка в 25% складатиме 1 день.

Таблиця 1.1 – Типи зв'язків між задачами
	Зв'язок
	Тип
	Опис
	Подання на

	
	
	
	діаграмі Ганта

	
	
	
	

	Закінчення-
	
	Попередник закінчується, і
	

	Початок
	FS
	
	

	
	
	починається наступна задача
	

	(Finish-Start)
	
	
	

	Початок-
	
	Початок попередника
	

	Закінчення
	SF
	визначає закінчення
	

	(Start-Finish)
	
	наступної задачі
	

	Закінчення-
	
	Обидві задачі закінчуються
	

	Закінчення
	FF
	
	

	
	
	одночасно
	

	(Finish-Finish)
	
	
	

	
	
	
	

	Початок-
	
	Задача починається
	

	Початок (Start-
	SS
	
	

	
	
	одночасно з попередником
	

	Start)
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Існує декілька способів установки й редагування зв'язків в Projectlibre.

Оберіть задачі, які ви прагнете зв'язати. Задача з меншим номером ID буде трактуватися як попередник. Потім для установки зв'язку натисніть у меню [Task » Link].

Інший спосіб – установка й редагування зв'язків за допомогою мишки – виконується шляхом перетаскування однієї задачі на іншу в діаграмі Ганта
За замовчуванням ProjectLibre встановлює зв'язок типу Закінчення-Початок (FS). Для зміни зв'язку необхідно двічі клацнути по стрілці зв'язку на діаграмі Ганта, а потім у вікні Залежність задач (Task Dependancy) обрати необхідний тип зв'язку й указати затримку.(рис. 1.8).

Для швидкої установки попередників задачі можна скористатися полем Predecessors таблиці задач. У ньому через крапку з комою необхідно вказати ID задач-попередників. Тип зв'язку встановлюється за замовчуванням FS. У тих випадках, коли необхідний зв'язок іншого типу, крім номера задачі необхідно вказати англійську абревіатуру типу зв'язку (рис. 1.9).





[image: ]
Рисунок 1.8 – Установка типу залежності між задачами

[image: ]
Рисунок 1.9 – Попередники задач

Також можна редагувати зв'язки в діалоговому вікні Інформація про задачу, як показано на рис. 1.10.



[image: ]
Рисунок 1.10 – Установка попередників для задачі

Щоб видалити зв'язок, виберіть дві задачі й скористайтеся меню [Task » Unlink].

Не намагайтеся видалити зв'язок шляхом видалення комірки в стовпці попередника натисканням клавіші <Del>, тому що при цьому віддалиться вся задача.

[bookmark: _heading=h.2xcytpi]1.2.7 Обмеження

Деякі задачі можуть бути прив’язані до певної дати. Розглянемо застосування прив'язки задач до певних дат при складанні плану проекту. Прив'язка задач до дат у середовищі ProjectLibre виконується за допомогою параметра Обмеження (Constraint). Існує 8 типів обмежень (рис. 1.11). Обмеження бувають двох категорій – гнучке обмеження й негнучке обмеження.
Установка обмеження проводиться в такий спосіб (рис. 1.11).

[image: ]
Рисунок 1.11 – Установка обмеження для задачі

1. Відкрийте діалогове вікно Інформація про задачу.
2. Перейдіть на вкладку Додатково й виберіть Тип обмеження

зі списку.
3. Укажіть значення Дати обмеження.

Негнучкі обмеження суттєво обмежують можливість планування та можуть викликати конфлікти між наступною й попередньою задачами, що може викликати необхідність видалити такі обмеження.

[bookmark: _heading=h.3whwml4]1.2.8 Установка контрольного строку

Встановіть дату контрольного строку (Deadline), щоб не ставити негнучке обмеження. Установка контрольного строку ніяк не впливає на розрахунок графіка проекту. Контрольний строк позначається на діаграмі Ганта жовтим ромбом. Якщо строк пройшов,

· задача не була виконана, ProjectLibre укаже це в першому стовпці таблиці задач Індикатор (хрестик у червоному кружку, у списку задач при виводі діаграми Ганта).

[bookmark: _heading=h.2bn6wsx]1.2.9 Критичний шлях проекту

Критична задача (Critical task) – це задача, що не має резерву часу. Будь-який зсув дати завершення такої задачі на більш пізній строк приведе або до зсуву наступної задачі, або до запізнювання проекту в цілому.

Критичний шлях (Critical path) – це послідовність взаємозалежних критичних задач, що з'єднує початкову й кінцеву дати проекту. Іншими словами це найбільш довгий маршрут у мережній діаграмі проекту. Критичний шлях визначає мінімально можливу тривалість проекту при заданій структурі. Будь-які затримки на критичному шляху затримують закінчення проекту.
В ProjectLibre на діаграмі Ганта критичні задачі відображаються червоним кольором, а не критичні – синім кольором. Для некритичних задач також можна відобразити часовий резерв (Total Slack) в контекстному меню на діаграмі Ганта.

1.2.10 [bookmark: _heading=h.qsh70q]Підготовка звітів по проекту

В ProjectLibre не так багато варіантів для формування звітів, якщо порівнювати з комерційними продуктами. Однак подання інформації у звітах проводиться з достатньою якістю.

Дата звіту про стан (або контрольна дата, Status date) – це дата, на яку слід одержати інформацію про стан проекту. За замовчуванням датою звіту про стан вважається поточна дата. Користувач може вибирати контрольну дату довільно, але з однією умовою: вона повинна бути розташована на осі часу «лівіше» поточної дати.

[bookmark: bookmark=id.3as4poj]Фільтрація дозволяє в будь-який момент накладати певні умови на спосіб виводу інформації (у тому числі й для звітів). Ви можете сховати інформацію, яку ви не прагнете бачити або виділити важливу інформацію, змінити порядок сортування даних, об'єднати їх

· групи (наприклад, по виконанню, критичності, по залучених ресурсах). Для цього використовується пункт меню [View » Filters].

Для формування звітів по проекту виберіть пункт меню [View» Other views » Report].

Тип звіту – це тип або категорія звіту, що визначає, якого роду інформація про проект повинна бути поміщена в друкований документ. В ProjectLibre передбачено 4 категорії звітів: 
– загальні відомості про проект (Project details);
– інформація про ресурси (Resource information);

– інформація про задачі (Task information);
– призначення (Who Does What).

[bookmark: _heading=h.1pxezwc]1.3 Завдання та порядок виконання роботи

1.3.1 Використовуючи рекомендовану літературу й дані методичні вказівки, ознайомтеся з основними принципами роботи із програмами для керування проектами в цілому й зокрема із системою ProjectLibre.

1.3.2 Докладно ознайомтеся із проектним завданням до лабораторної роботи, наведеним у додатку А.

1.3.3 Створіть новий проект. Виберіть спосіб планування від дати початку проекту. Налаштуйте календар, у якому святкові дні відзначте як неробочі. Уведіть дату початку проекту, скорегувавши строки проектного завдання так, щоб початок проекту збігся з початком семестру.

1.3.4 Створіть план проекту відповідно до проектного завдання. У таблицю задач уведіть сумарну задачу, етапи, додайте задачі, обмеження, тривалості задач, визначте зв'язки між задачами.

1.3.5 Придумайте й внесіть у проект свою невелику задачу.

1.3.6 Внесіть у план проекту необхідні затримки й випередження виконання робіт.

1.3.7 Забезпечте відповідність отриманих та установлених у завданні строків виконання етапів робіт.
1.3.8 Встановіть контрольний строк завершення останньої задачі проекту трьома днями пізніше планового строку її завершення.
1.3.9 Визначите тривалість проекту.
[bookmark: bookmark=id.49x2ik5]1.3.10 Підготуйте наступні звіти: Загальні відомості про проект (Project Details), Задачі проекту (Task Information=>Default), Діаграма Ганта, Мережний графік, Ієрархічна структура робіт проекту, Критичні й некритичні задачі й часові резерви задач (Task Information=>Schedule CPM).

[bookmark: _heading=h.2p2csry]1.4 Контрольні питання

1. Яке призначення систем керування проектами?
2. Як визначається тривалість виконання проекту?

3. Що таке критична задача й критичне шлях? Що таке часовий резерв задачі?

4. Які типи залежностей між задачами існують і як вони впливають на розрахунки календарного плану проекту?

5. Як використовувати запізнювання й випередження при формуванні залежностей між задачами?
6. Для чого необхідні календарі?

7. Що таке віхи й навіщо вони необхідні?
8. Для чого необхідно структурувати задачі проекту?
9. Що таке обмеження задач і які вони бувають?

10. Що таке крайній строк виконання задачі і як його можна використовувати?

11. Яким чином можна врахувати перерви у виконанні задач?

[bookmark: _heading=h.3o7alnk]
Лабораторна робота № 2 
Планування ресурсів, створення призначень і вартісний аналіз проекту

[bookmark: _heading=h.23ckvvd]2.1 Мета роботи

Вивчення особливостей планування призначень для співробітників і матеріальних ресурсів, а також принципів розподілу завантаження ресурсів під час виконання задач, проведення вартісного аналізу проекту.

[bookmark: _heading=h.ihv636]2.2 Основні теоретичні положення та методика викладання роботи

[bookmark: _heading=h.32hioqz]2.2.1 Ресурси проекту

Ресурси (Resource) – це компоненти, які забезпечують виконання проектних робіт. Вони включають виконавців, матеріали, устаткування, енергію тощо.

Ресурси бувають двох типів – робота й матеріали.

Ресурси типу Робота (Work) виконують задачі шляхом витрати часу на задачу. Звичайно це люди або устаткування.

Ресурси типу Матеріал (Material) – це запаси видаткових матеріалів і компонентів, які потрібні для виконання проекту.

Доступний для виконання роботи набір ресурсів називають пулом ресурсів. Після визначення необхідної кількості ресурсів, необхідно встановити час і доступність кожного ресурсу. У випадку трудових ресурсів, кількість часу, яку вони можуть працювати, буде вимірятися в годинах, днях місяцях або роках, а кількості матеріальних ресурсів повинні бути зазначені в одиницях виміру.

Доступність (Availability) – це період часу, протягом якого ресурс може бути використаний при виконанні конкретної задачі.
Доступність ресурсу визначається трьома факторами:

– календарями робочого часу проекту й даного ресурсу;
– датами початку й завершення використання ресурсу в проекті;
– сумарним обсягом призначень ресурсу на задачі проекту (максимальне використання).

Створення пулу ресурсів проводиться у Виді ресурсів, який дозволяє керувати списком ресурсів та витратами на ресурси.

[bookmark: _heading=h.41mghml]2.2.2 Заповнення списку ресурсів

Уведення ресурсів проводиться через таблицю Виду ресурсів (рис.2.1).
1. Для доступу до таблиці ресурсів скористайтеся меню
[Resource » Resources] або [View » Resource views » Resources].
2. Виберіть комірку в колонці Назва й укажіть назву ресурсу.

3. Укажіть тип ресурсу – Робота або Матеріал. Для матеріалів укажіть одиниці виміру.

[image: ]
Рисунок 2.1 – Вид списку ресурсів

У стовпці Максимальне використання (Maximum units) показане максимальне завантаження, яке можливе для ресурсу при виконанні будь-яких задач у певний період часу. За замовчуванням використовується формат відсотків. Наприклад, якщо зазначено 100%, це означає, що цей ресурс буде працювати всі вісім годин у звичайний робочий день. Якщо зазначено 50%, то цей ресурс буде працювати по чотири години на день. У випадку пулу ресурсів, що полягає з 5 працівників, їх максимальна кількість одиниць буде 500%.

Ресурси типу Матеріал не містять величини Максимальне використання. Одиниці таких ресурсів містять вартість споживання, яка може бути фіксованою або змінною.

При клацанні в таблиці ресурсів по назві ресурсу буде виведене вікно, що містить інформацію про ресурс (рис.2.2).

На вкладці General можна вказати індивідуальний календар ресурсу або змінити робочий час ресурсу.

Для редагування календаря ресурсу натисніть кнопку із зображенням календаря праворуч від поля вибору календаря зі списку й внесіть необхідні зміни.

[image: ]
Рисунок 2.2 – Вікно з інформацією про ресурс

· поле Group можна вказати професійну приналежність трудового ресурсу або вид матеріального ресурсу (наприклад, назва відділу або назва групи матеріалів).

[bookmark: _heading=h.vx1227]2.2.3 Методи нарахування

Плануючи вартість проекту, необхідно не тільки визначити його бюджет, але й визначити, як цей бюджет буде витрачатися протягом усього проекту. Витрата бюджету залежить від порядку оплати робіт.

Оплачувати роботу можна різними способами: може використовуватися передоплата, оплата за фактом завершення, а іноді,

· пропорційна оплата в міру виконання робіт, причому звичайно в проекті можуть використовуватися кілька способів оплати.

Метод нарахування витрат (Accrual method) – це метод обліку разових або фіксованих витрат, що входять у вартість роботи. В ProjectLibre передбачено три методи нарахування витрат:

– на дату початку задачі (start);
– на дату завершення роботи (end);
– метод рівномірного розподілу на період виконання задачі
(prorated).

Слід урахувати, що порядок оплати робіт не впливає на загальну суму витрат по проекту.

2.2.4 [bookmark: _heading=h.3fwokq0]Визначення витрат на ресурси

В ProjectLibre є два типи витрат, що визначають вартість ресурсів проекту: погодинна ставка (стандартна та понаднормова ставка) і витрати за використання.

[bookmark: bookmark=id.1v1yuxt]Таблиця норм витрат (Cost rate table) – це набір значень витрат на ресурс, що включає стандартний і понаднормовий тариф оплати ресурсу, вартість разового використання ресурсу, а також інтервали часу, протягом яких діє той або інший тариф.

Вартість ресурсу визначається у відповідних стовпцях таблиці у виді Ресурси або у вікні Інформації про ресурс на вкладці Costs.

Ви можете вказати до 5 різних тарифних ставок для обраного ресурсу (A-E). У кожній з них ви можете вказати наступні ставки:
– стандартна ставка;
– ставка за переробку;
– ставка за кожне використання ресурсу.

Щоб внести витрати на ресурс виконайте наступне.

1. Відкрийте діалогове вікно Інформація про ресурс і виберіть вкладку [Costs] (рис.2.3).
2. Дата початку дії тарифу (Effetive date) може збігатися з датою початку проекту. Якщо це не так, укажіть дату або виберіть її з календаря.

3. Укажіть стандартну ставку (Standart rate). За замовчуванням вказується значення в грн/година, але ви можете при необхідності вказати ставку в /рік, або в /місяць.
4. Укажіть ставку за переробку (Overtime rate). Її необхідно вказувати, навіть якщо вона дорівнює стандартній ставці.
5. Укажіть додаткову ставку за використання ресурсу

(вартість доставки й таке інше), яка не залежить від того, скільки часу задіяний ресурс у задачі.

[image: ]
Рисунок 2.3 – Вікно інформації про ресурс, вкладка «Вартість»



6. Якщо ви знаєте, що ставки можуть мінятися під час виконання проекту, клацніть на другому рядку, укажіть ефективну дату дії й внесіть нові стандартну ставку, ставку за переробку й ставку за використання. Ви можете вказати або абсолютні величини, або збільшення або зменшення в % від ставок, перерахованих у першому рядку.

7. Укажіть метод нарахування шляхом вибору зі списку, що випадає [Accrue at].

При створенні призначення дані про ставку ресурсу за замовчуванням беруться з таблиці A норм витрат. Змінити вартість призначення можна, указавши іншу таблицю норм витрат для потрібного ресурсу. Таблиця норм витрат вказується у вікні інформації про задачу на вкладці Resourses колонка Cost Rate Table.

[bookmark: _heading=h.2u6wntf]2.2.5 Призначення ресурсів на задачі

Наступний крок після визначення ресурсів – призначення ресурсів на задачі.

Призначення (Assignment) – це елемент розкладу проекту, що відбиває взаємозв'язок між задачею і ресурсом, призначеним для її виконання. Змістовна інтерпретація цього терміна залежить від «кута зору»: з погляду розподілу ресурсів – це величина працезатрат ресурсу для виконання конкретної задачі; з погляду параметрів задачі
– це її трудомісткість (обсяг робіт), що доводиться на даний ресурс.

Для того щоб призначити ресурс на задачу, необхідно виконати наступні дії.

1. На діаграмі Ганта виберіть задачу, на яку потрібно призначити ресурс, і виберіть меню [Task » Assign Resources].
Або.

1. Відкрийте вікно інформації про задачу. Перейдіть на вкладку Resources і натисніть кнопку [Assign Resources].

2. У вікні, що відкрилося (рис. 2.3) виберіть ресурс, який ви прагнете призначити на задачу.

3. Для робочих ресурсів укажіть відсоток участі в стовпці Units. Одиниці (обсяг призначень, units) для робочих ресурсів – це кількість виконавців (або часток ресурсу), призначених на задачу.

4. [bookmark: bookmark=id.19c6y18]При призначенні матеріальних ресурсів можна вказати як фіксований обсяг виділюваних на задачу ресурсів (наприклад, 2 коробки), так і змінний обсяг (наприклад, 1 коробка в день). Для матеріальних ресурсів виберіть поле Одиниці, натисніть <F2> і вкажіть кількість призначуваних одиниць або дані у форматі: число одиниць/позначення тривалості (3/d або 3/д для позначення витрати трьох одиниць матеріалу в день). Якщо ви залишите поле порожнім, буде встановлене значення за замовчуванням 1. ProjectLibre додасть одиниці виміру до зазначеного вами десяткового значення.
5. Натисніть кнопку [Assign] для підтвердження.

Щоб вилучити призначення в задачі, виберіть завдання, потім назву ресурсу, який потрібно вилучити, і натисніть клавішу <Del>.


[image: ]
Рисунок 2.3 – Призначення ресурсів на задачу


Після призначення ресурсів на задачу ProjectLibre визначає працезатрати кожного з ресурсів для виконання цієї задачі й планує розподіл цих працезатрат на кожний із днів протягом усієї тривалості задачі.

· ProjectLibre тривалість (duration) відповідає часу, через який буде отриманий результат задачі або іншими словами кількість часу між початком і закінченням задачі, а працезатрати або робота (work) відповідають часу, витраченому відповідальним виконавцем для одержання результату.

При призначенні ресурсів на задачі ProjectLibre перемножує тривалість завдання (D) на зазначені відсотки або одиниці виміру ресурсів (U) для визначення робочих годин (W), які будуть витрачені на задачу (D*U=W).
При першому призначенні ресурсів на задачу, працезатрати обчислюються і фіксуються.

Наприклад, для розробки деякого модуля програми встановлена тривалість в 5 днів і призначено 3 ресурси із завантаженням 100%. Припускаючи, що в дні за замовчуванням 8 робочих годин, кожний із цих ресурсів повинен буде працювати по 8 годин усі 5 днів. Повні працезатрати на задачу становлять 120 людино-годин.

При повторному призначенні ресурсів на задачу буде проведений перерахунок тривалості й роботи залежно від Типу задачі.

[bookmark: _heading=h.28h4qwu]2.2.6 Типи задач

ProjectLibre визначає три типи задач (Task type), які дозволяють перерахувати значення змінних, коли на завдання робиться нове призначення ресурсів:

– фіксовані одиниці / фіксований обсяг ресурсів (Fixed Units);

– фіксовані працезатрати (Fixed Work);
– фіксована тривалість (Fixed Duration).

Тип задачі визначає, як редагування однієї із властивостей задачі – тривалості, працезатрат або призначень – буде впливати на дві інші властивості. Обраний тип задачі визначає, значення якої із властивостей буде зафіксовано. Тривалість – це змінна завдання, а кількість одиниць і працезатрати – це змінні призначення.
Розглянемо кожний з типів задач.

Тип задачі Fixed Duration означає, що зміна працезатрат або числа призначених на виконання задач співробітників не змінить її тривалість

Тип Fixed Work (Фіксовані працезатрати) установлюється для задач, виконання яких вимагає строго певних працезатрат. Чим більше співробітників призначено на задачу, тем менший обсяг роботи припадає на кожного з них і тем швидше задача буде виконана.

Тип Fixed Units (Фіксований обсяг ресурсів) використовується в плані проекту для задач, тривалість і обсяг роботи для яких повністю залежать від виділених на них ресурсів. Тривалість задач із фіксованим обсягом ресурсів дорівнює працезатратам діленим на число призначених ресурсів.
[bookmark: bookmark=id.nmf14n]Увипадку якщо задача не відноситься до типу Фіксовані працезатрати, додатково до позначення типу задачі можна використовувати прапорець Фіксованого обсягу робіт (effort-driven).
Якщо включити дану ознаку, то працезатрати будуть зафіксовані одночасно з однією із двох інших ознак задачі: тривалістю або обсягом ресурсів.
Керівник проекту повинен проаналізувати кожну задачу проекту і вибрати для неї відповідний тип. Розглянемо приклад в таблиці 2.1.
Нехай існує задача тривалістю 5 днів. На неї призначено один трудовий ресурс обсягом 100%. Таким чином, працезатрати на задачу становлять 40 год. 
За замовчуванням тип задачі встановлений в значення «фіксований обсяг ресурсів» (Fixed Units) і відзначений прапорець «фіксований обсяг робіт». Тривалість задачі при цьому залежить лише від кількості призначених на неї ресурсів. Якщо ви зміните кількість ресурсів після початкового призначення, ProjectLibre змінить тривалість, але залишить вихідний обсяг робіт.

Щоб змінити тип задачі необхідно виконати наступне: відкрийте вікно інформації про задачу, виберіть вкладку Advanced і в списку вибору Type виберіть необхідний тип задачі (рис. 2.4).
Таблиця 2.1 – Приклад задач трьох типів
	Тип задачі
	Варіант змін
	
	Результат

	фіксована
	Тривалість – 10 днів
	Працезатрати – 80 годин

	тривалість
	Працезатрати – 48 годин
	Обсяг
	призначення

	
	
	
	ресурсу – 120%

	
	Обсяг
	призначення
	Працезатрати – 20 годин

	
	ресурсу – 50%
	
	

	
	Додаємо
	аналогічний
	Працезатрати – 80 годин

	
	ресурс
	
	
	

	фіксовані
	Тривалість – 10 днів
	Обсяг
	призначення

	працезатрати
	
	
	ресурсу – 50%

	
	Працезатрати – 48 годин
	Тривалість – 6 днів

	
	Обсяг
	призначення
	Тривалість – 10 днів

	
	ресурсу – 50%
	
	

	
	Додаємо
	аналогічний
	Тривалість – 2,5 дня

	
	ресурс
	
	
	

	фіксований
	Тривалість – 10 днів
	Працезатрати – 80 годин

	обсяг ресурсів
	Працезатрати – 48 годин
	Тривалість – 6 днів

	
	Обсяг
	призначення
	Тривалість – 10 днів

	
	ресурсу – 50%
	
	

	
	Додаємо
	аналогічний
	Працезатрати – 80 годин

	
	ресурс
	
	
	






Ви можете вивести інформацію про призначення ресурсів на задачі за допомогою пункту меню [Views » Task Usage].
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Рисунок 2.4 – Зміна типу задачі
[bookmark: _heading=h.1mrcu09]2.2.7 Визначення вартості проекту

Наступний етап – це формування витрат проекту. Витрати проекту складаються з вартості використання ресурсів ( як матеріальних, так і трудових) і фіксованих витрат на задачі (витрат, не пов'язаних з використанням проектних ресурсів).

Фіксовані витрати на задачу (Fixed cost)– це витрати, не пов'язані з використанням проектних ресурсів. Для впровадження фіксованих витрат використовується поле фіксованих витрати в таблиці задач (стовпець фіксованих витрат можна вставити нажавши правою кнопкою миші на заголовках стовпців у таблиці й вибравши Insert Column => Fixed Cost) (рис. 2.5).

[image: ]
Рисунок 2.5 – Додавання стовпця Фіксованих витрат


[bookmark: _heading=h.46r0co2]2.2.8 Контури

[bookmark: bookmark=id.2lwamvv]За замовчуванням при створенні призначення працезатрати розподіляються по всій його тривалості, використовуючи максимум робочого часу ресурсу.
Контур (Work Contour) або профіль завантаження в ProjectLibre

– це форма розподілу робіт усередині призначення. Звичайно, якщо ресурсу призначають 100% використання в 40-годинній задачі, задача буде розпочата негайно з роботою по 8 годин на день впродовж 5 днів. Це – плоский контур за замовчуванням, де робота кожного підрозділу рівномірно розподіляється по всій тривалості задачі.



Іноді вам може знадобитися змінити розподіл роботи над задачею. ProjectLibre містить у собі 8 визначених контурів (рис.2.6).
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Рисунок 2.6 – Вибір профілю завантаження ресурсу

Розглянемо особливості кожного контуру:

– плоский – контур за замовчуванням з рівномірним розподілом роботи;

– завантаження наприкінці – пік активності виникає наприкінці задачі;

– завантаження на початку – пік активності виникає на початку задачі;
– подвійний пік – у задачі існують два піки активності;

– ранній пік – такої ж, як на початковому етапі, але з рампою до піка активності;

– пізній пік – пік активності наприкінці проекту, але з рампою;
– «дзвін» – одиночний пік активності в середині проекту;

– «черепаха» – плоске завантаження без виражених піків, з рампами на початку й наприкінці.

Змінити робочий контур для призначення можна у поданні Використання задач (Task Usage).

[bookmark: _heading=h.3l18frh]2.2.9 Базовий план проекту

Базовий план проекту (Baseline plan) – це розклад, вартість і зміст проекту, які використовуються в якості еталонних при керуванні ходом виконання проекту. Базовий план використовується для виконання аналізу поточної продуктивності в порівнянні із затвердженим планом.

По закінченню планування й до початку виконання зберігається «знімок» проекту як базового плану ([File »Project » Save Baseline]).

Крім того в проекті може бути кілька базових планів (до 10), які звичайно зберігаються в найбільш важливі ключові моменти проекту.

При збереженому базовому плані на діаграмі Ганта під кожною задачею відображаються тіні, що відповідають базовому розкладу.

[bookmark: _heading=h.206ipza]2.2.10 Графіки

· ProjectLibre є можливість спостерігати за вартістю й роботою проекту за допомогою графіків.

Для того щоб переглянути графіки, необхідно наступне.
1. Вибрати пункт меню [View » Sub-views » Charts].

2. У таблиці задач вибрати необхідні задачі (чи всі задачі
проекту).
3. [bookmark: bookmark=id.4k668n3]У панелі, що з'явилася знизу головного вікна, вибрати необхідні ресурси.

4. Налаштувати необхідні параметри для відображення: вибрати перемикач робота/вартість і зі списку вибрати відображувані величини.

Наприклад, розглянемо Графік витрати бюджету проекту (рис.2.7).

Точно так само можна переглядати графіки, що стосуються робіт проекту, що залишилися для виконання. Для цього необхідно змінити перемикач у положення «робота».
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Рисунок 2.7 – Графік витрати бюджету

[bookmark: _heading=h.2zbgiuw]2.3 Завдання та порядок виконання роботи

2.3.1 Відкрийте проект, створений у лабораторній роботі №1.
2.3.2 Створіть список трудових ресурсів, які будуть використовуватися в проекті згідно із проектним завданням. Придумайте й додайте в проект два матеріальні ресурси.
2.3.3 Уведіть стандартні ставки для трудових ресурсів проекту відповідно до проектного завдання. Понаднормові ставки встановіть в 1,5-2 рази більше стандартних.
2.3.4 Призначте ресурси на задачі проекту. При виконанні призначення використовуйте матрицю задач і відповідальності проекту (див. табл. А.5). При цьому вмовимося, що основна відповідальність означає 100% призначення ресурсу на задачу, а допоміжна – від 1 до 99% (залежить від задачі). Зверніть увагу, що тривалість виконання задач за проектним завданням фіксована.
2.3.5 Для задачі, створеної у лабораторній роботі №1 п.1.3.5, введіть фіксовану вартість.
2.3.6 Визначите час участі ресурсів у проекті.
2.3.7 Визначите вартість етапів робіт і проекту в цілому.

2.3.8 Збережіть базовий план проекту №1.

2.3.9 Порівняйте отриману вартість проекту із затвердженим бюджетом. Розбіжність із затвердженим бюджетом у даній роботі є можливою.
2.3.10 Підготуйте наступні звіти: Загальні відомості про проект (Project Details), Task Usage, Список ресурсів (Resource information=>Default), Використання ресурсів (Who does what=>Basic report), Рух коштів по проекту (Task Information=>Cost, Baseline), Графік витрати бюджету.
2.3.11 Створіть копію отриманого плану проекту й проведіть серію експериментів для вивчення властивостей призначень:
а)	визначити персональний календар для одного ресурсу проекту;
б)	нехай один з виконавців не працює над проектом по п'ятницях в одному з місяців (наприклад, у жовтні), а інший в ці дні працює половину робочого дня;
в)	розподілити завантаження ресурсів під час виконання завдань за допомогою профілів, визначте різні профілі завантаження для деяких задач;
г)	проведіть дослідження по вивченню впливу властивостей задач різних типів на параметри призначення;
д) реалізувати перерву у виконанні однієї із задач;
е)	внесіть зміни ставки співробітника з деякої встановленої дати до завершення проекту, визначте різні норми витрат для ресурсу, призначеного на кілька різних задач.
Включіть у звіт результати трьох експериментів і проаналізуйте отримані результати.
2.3.12 Підготуйте звіт за лабораторної роботи.

[bookmark: _heading=h.3ygebqi]2.4 Контрольні питання

1. Що таке ресурси і яких типів вони бувають?
2. Для чого необхідні календарі ресурсів?
3. Як визначається вартість проекту?
4. Як визначаються витрати на задачу?

5. Що таке бюджет проекту й що таке витрата бюджету?
6. Що таке фіксовані витрати на задачу?
7. Що таке метод нарахування при розрахунках витрат?

8. Що таке контур або профіль завантаження?

9. [bookmark: bookmark=id.sqyw64]Як розподіляти завантаження ресурсів у рамках призначення за допомогою профілів?

[bookmark: _heading=h.3cqmetx]
Лабораторна робота № 3 
Аналіз завантаження ресурсів і оптимізація параметрів проекту

[bookmark: _heading=h.1rvwp1q]3.1 Мета роботи

Отримання практичних навичок проведення аналізу та оптимізації завантаження ресурсів та оптимізації параметрів проекту.

[bookmark: _heading=h.4bvk7pj]3.2 Основні теоретичні положення та методика викладання роботи

[bookmark: _heading=h.2r0uhxc]3.2.1 Перевантажені ресурси

Перевантаження ресурсів – це перевищення в процесі планування максимально можливого для цього ресурсу обсягу призначення, передбаченого в певний проміжок часу.

Поява в проекті перевантаженого ресурсу може бути викликане наступними причинами:

– призначення ресурсу на задачу в кількості, що перевищує максимально припустимий обсяг призначень (макс. одиниці);

– одночасне призначення ресурсу на дві або більш задачі, у результаті чого сумарний обсяг призначень перевищує максимально припустимий;

– призначення ресурсу на задачу, що виконується в період недоступності ресурсу (у його неробочий час).

Перевищення завантаження ресурсу можна знайти, відкривши додаткову панель із виводом Гістограми завантаження ресурсів.

Графік завантаженості ресурсу представляє собою стовпчасту діаграму, у якій на горизонтальній осі відображаються дати, а на вертикальній осі вказується обсяг призначень ресурсу (рис. 3.1). Чорною лінією позначається рівень доступності ресурсу, тобто припустимий обсяг призначень. Рівень завантаження ресурсу, що перевищує встановлене для нього максимальне значення, виступає на діаграмі за границю чорної лінії.

3.2.2 Шляхів усунення перевищень завантаження ресурсів

Вирівнювання ресурсів – це процес реорганізації плану проекту з метою ліквідації перевантаженості його ресурсів.

При виявленні перевищення завантаження ви можете:
– змінити розподіл працезатрат через профіль завантаження;
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Рисунок 3.1 – Подання перевантаженого ресурсу

– затримати виконання задачі або вставити в задачі перерву;
– змінити обсяг призначень ресурсу на задачу;

– реорганізувати сітковий графік робіт;
– замінити перевантажений ресурс іншим вільним;

– урахувати наднормативні працезатрати ресурсів як понаднормові (не більш 2 – 3 годин на добу).
У деяких випадках може виявитися досить корисним змінити робочий час ресурсу за допомогою календаря ресурсу або уточнити періоду часу, протягом якого даний ресурс буде задіяний для виконання конкретної задачі. Справа в тому, що за замовчуванням ProjectLibre уважає, що призначений на задачу ресурс бере участь у її виконанні на всім протязі задачі, від першої до останньої хвилини. Щоб указати період часу, протягом якого ресурс реально повинен брати участь у виконанні задачі, можна скористатися полем Assignment Delay в призначенні Ресурсу.
Вибір способу вирівнювання перевантаженого ресурсу прямо залежить від причини перевантаження.

[bookmark: _heading=h.25b2l0r]3.2.3 Оптимізація параметрів проекту

Після того, як сформовано план проекту й обчислено його часові параметри й вартість, при наявності часових або грошових резервів можна спробувати поліпшити його показники:

– закінчити проект раніше спочатку наміченого строку при збереженні сформованого бюджету;

– підвищити якість робіт ( за допомогою залучення кращих ресурсів) за рахунок збільшення бюджету, при збереженні строків виконання робіт;

– підвищити якість робіт за рахунок збільшення часу, що приділяється на них, при збереженні бюджету;

– зберегти розраховані строки виконання робіт, забезпечивши економію матеріальних засобів.
Однак значно більш складні проблеми виникають у тих випадках, коли розроблювач проекту одержує план, параметри якого не вміщаються в часові й/або бюджетні рамки.

Для вирішення позначених проблем використовують методи оптимізації строків і вартості проектних робіт. Класичними методами аналізу й оптимізації плану робіт є методи PERT (Program Evalution and Rewiew Technique, техніка оцінки й перегляду програм) і метод критичного шляху CPM (Critical Path Method).

[bookmark: _heading=h.kgcv8k]3.2.4 Оптимізація строків проекту

При оптимізації часових параметрів проекту необхідно визначити критичний шлях і спробувати скоротити його. Для цього можна застосувати наступні способи:

– перекриття задач;
– планування переробки й/або зміна календарів ресурсів;
– поділ тривалих задач на більш дрібні;
– пошук і виправлення помилок планування.

Як самий радикальний метод зміни строку завершення проекту можна застосувати зміну дати початку проекту.

[bookmark: _heading=h.34g0dwd]3.2.5 Оптимізація бюджету

При оптимізації бюджету доцільно дотримуватися наступного порядку дій.

1. Виявити задачі, що викликають перевищення бюджету.
2. Визначити наявність резервів часу для задач, які не укладаються в бюджет.
3. Зберегти резервну копію плану,
4. Скорегувати состав і розподіл ресурсів з метою зниження
витрат.
5. Оцінити результати оптимізації плану.

Засоби, які здатні допомогти менеджерові виявити недоліки проекту на етапі планування:

– фільтри для відбору завдань із перевищенням витрат;
– звіти про витрати.

[bookmark: _heading=h.43ky6rz]3.3 Завдання та порядок виконання роботи

3.3.1 Відкрийте проект, створений у лабораторній роботі №2.
3.3.2 Отримайте список ресурсів з перевищенням завантаження. Якщо перевантажені ресурси не виявлені, створіть варіант (копію) плану, у якому присутні як мінімум два перевантажені ресурси з урахуванням наступних обставин:

– ресурсу призначений на задачу в кількості, що перевищує його максимально припустимий обсяг призначень;
– одночасне призначення ресурсу на дві або більше задачі;

– призначення ресурсу на задачу, що виконується в період його недоступності.

3.3.3 Виконайте аналіз плану для кожного перевантаженого ресурсу та сформулюйте способи вирівнювання.
3.3.4 Усуньте перевантаження ресурсів.
3.3.5 Підготуйте звіт щодо проведеної оптимізації.
3.3.6 Збережіть новий базовий план проекту №2.

3.3.7 Створіть копію отриманого плану проекту й проведіть серію експериментів:

а) перенесіть дату початку проекту на тиждень уперед; внесіть зміни в план проекту таким чином, щоб його тривалість зменшилася й проект уклався в строк;

б) визначте критичний шлях проекту; вивчите специфіку задач критичного шляху; змініть план так, щоб зменшити число задач на критичному шляху;

в) скоротіть тривалість критичного шляху проекту за рахунок перегляду і зміни типів залежностей між задачами;
г) скоротіть тривалість критичного шляху проекту за рахунок планування робіт у понаднормовий час;

д) скоротіть тривалість критичного шляху проекту за рахунок призначення додаткових ресурсів.

Додайте до звіту результати трьох експериментів і проаналізуйте отримані результати.
3.3.8 Проведіть	огляд	витрат	в	отриманому	плані	проекту.
Визначите задачі з перевищенням бюджету.

3.3.9 Оптимізуйте план у випадку розбіжності вартості етапів і робіт із затвердженими витратами, наведеними в проектному завданні.
3.3.10 Сформуйте звіт про рух коштів по проекту.

3.3.11 Створіть копію отриманого плану проекту й проведіть серію експериментів:

а) внесіть зміни, у результаті яких отриманий бюджет проекту перевищує можливості замовника; тепер Вам необхідно зменшити бюджет на 10%; для цього Ваше керівництво дозволяє використовувати більш низькі таблиці норм витрат у ресурсів;

б) визначите, на який з матеріальних ресурсів іде найбільше коштів, і яка повинна бути вартість ресурсу щоб знизити проектні витрати на 5%; у випадку, якщо вартість ресурсів становить менше 5% проектних витрат, збільшити вартість ресурсів для проведення аналізу.

Додайте до звіту результати одного експерименту і проаналізуйте отримані результати.

3.3.12 Підготуйте звіт за лабораторної роботи.

[bookmark: _heading=h.xvir7l]3.4 Контрольні питання

1. Перелічіть причини появи перевантаження ресурсів у проекті.

2. Яким чином усувається перевантаженість ресурсів?
3. Які дії необхідно виконати для оптимізації бюджету проекту?
4. Які дії необхідно виконати для оптимізації строків проекту?
5. З якою метою виконують виявлення задач із перевищенням вартості?
6. Яким чином здійснюється підвищення рівня доступності ресурсу в проекті?
7. Яким чином можна скоротити критичний шлях проекту?

8. З якою метою проводиться зміна календарів проекту?

[bookmark: _heading=h.4h042r0]
Лабораторна робота № 4 
Керування виконанням проекту

[bookmark: _heading=h.2w5ecyt]4.1 Мета роботи

Одержання практичних навичок відстеження ходу виконання проекту.

[bookmark: _heading=h.1baon6m]4.2 Основні теоретичні положення та методика викладання роботи

[bookmark: _heading=h.3vac5uf]4.2.1 Відстеження роботи

Крім робіт з якісного керування проектом, ефективний керівник проекту повинен гарантувати, що мета проекту буде досягнута в строк

· в рамках бюджету. При відставанні завдань від графіка або перевитраті бюджету необхідно переглянути плани проекту, перерозподілити ресурси і найти способи мінімізації впливу на час і витрати.

Важливо зберегти початковий план проекту в якості базового, а потім зрівняти його з фактичним.

ProjectLibre обчислює для задач розбіжність із базовими значеннями дат початку й закінчення, тривалості робіт і витрат. Ви можете відобразити цю розбіжність на діаграмі Ганта, нажавши праву кнопку миші й вибравши в контекстному меню, який з базових станів повинен бути виведений (рис. 4.1).

При відстеженні на діаграмі Ганта ProjectLibre показує базові завдання сірим кольором, а фактичні або заплановані – синім або червоним кольором.

При регулярному оновленні стану проекту ProjectLibre дозволяє менеджерові спрогнозувати дату його завершення.

[bookmark: _heading=h.2afmg28]4.2.2 Заповнення фактичних даних задачі

Ви можете змінити більшість даних проекту в списку завдань. Цей вид містить поля фактичних початку й закінчення, відсоток завершення, витрат і тривалості робіт.

Для того щоб ввести данні в таблицю, необхідно наступне.
1. Виберіть комірку, у якій необхідно змінити дані.

2. Якщо це поле типу «Дата», ви можете вибрати дату з календаря, нажавши кнопку зі стрілкою праворуч від значення в комірці.
Для введення деяких числових значень (наприклад, %), ви можете використовувати кнопки зі стрілками в комірці для збільшення й зменшення значень. Ви можете вносити значення відсотків виконання задач у таблиці задач або за допомогою меню [Task » Task » Update].

Крім того відсоток виконання можна змінити на діаграмі Ганта. При наведенні покажчика на задачу, коли покажчик прийме форму знака відсотка зі стрілкою, нажати ліву кнопку миші й, не відпускаючи її, перемістити показник уздовж відрізка задачі вправо на необхідну відстань. При цьому усередині відрізка завдання з'явиться темна лінія, довжина якої відповідає чисельному значенню параметра

· завершення.
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Рисунок 4.1 – Відстеження робіт: контекстне меню


Також можливо оновити відсоток виконання проекту в цілому і система автоматично обчислить відсотків виконання всіх задач проекту. Щоб скористатися цією функцією, виберіть у меню пункт [File » Project » Update].

[bookmark: _heading=h.1opuj5n]4.2.3 Аналіз освоєного обсягу

Аналіз плану й фактичного виконання обсягу робіт дозволяє судити про реальний стан проекту.

Аналіз освоєного обсягу (Earned value analysis) – це метод оцінки ефективності реалізації проекту за критеріями вартості.

За допомогою методу освоєного обсягу здійснюють контроль наступних трьох ключових показників.

Базова вартість запланованих робіт (BCWS, Budgeted Cost of Work Scheduled) або погодинні витрати за базовим планом від початку проекту на поточну дату (current) або контрольну дату (status) звіту:

BCWS = базова вартість години * кількість базових годин.

Базова вартість виконаних робіт (BCWP, Budgeted Cost of Work Performed) або базова вартість фактично витрачених годин, обчислена в припущенні, що ставка оплати ресурсів відповідає плановій:

BCWP = базова вартість години * фактична кількість годин.

Фактична вартість виконаних робіт (ACWP, Actual Cost of

Work Performed) або фактичні витрати, понесені для задач:

ACWP = фактична вартість години * фактична кількість годин.

Щоб подивитися значення показників, необхідно в таблицю задач додати ці стовпчики (BCWS, BCWP, ACWP). Крім того показники засвоєного обсягу можуть бути отримані у вигляді звіту (Task Information » Earned Value).

Ці три значення використовуються для розрахунків наступних показників, які й відображають результати аналізу.

Індекс виконання бюджету або індекс відхилення вартості (CPI, Cost Performance Index) - показує відношення освоєного обсягу до фактичних витрат:

CPI = BCWP / ACWP.

CPI показує, наскільки добре проект укладається в бюджет:

– CPI > 1, вартість нижче, чим було заплановано;
– CPI < 1, вартість вище, чим було заплановано.

Індекс виконання розкладу або індекс відхилення від календарного плану (SPI, Schedule Performance Index) - показує відношення освоєного обсягу до запланованих витрат:

SPI = BCWP / BCWS.

SPI показує, наскільки добре проект укладається в розклад:

– SPI > 1 показує, що проект випереджає розклад;
– SPI < 1 показує, що проект відстає від розкладу.

Відхилення від графіка (SV, Schedule Variance) - визначає різницею між плановою вартістю робіт із графіка виконаних робіт і плановою вартістю:

SV = BCWS – BCWP.

Вимірює, наскільки в грошовім вираженні виконання проекту випереджає або відстає від плану:
– SV>0 показує, що виконане більше робіт, чим заплановано;
– SV<0 показує, що виконане менше робіт, чим заплановано.
Відхилення по витратах (CV, Cost Variance) – це величина, що
відображує різницю фактичної й планової вартості виконаних робіт:

CV = BCWP – ACWP.

Вимірює, наскільки виконання проекту випереджає або відстає від плану:

– CV>0 показує, що виконано більше робіт, чим витрачено коштів;
– CV<0 показує, що витрачено більше коштів, чим виконано
робіт.

Чим більша величина показників SV і CV, тим більше різниця між реальною продуктивністю й планами.

[bookmark: _heading=h.2nusc19]4.2.4 Подання Діаграма Ганта

Розглянемо це подання як засіб контролю над дотриманням планових строків.
Для відстеження відхилення поточного положення проекту від базового необхідно відкрити Диаграму Ганта й додати в таблицю наступні колонки:

[bookmark: bookmark=id.1302m92]–	Початок поточна (зазначена в розкладі) дата початку виконання задачі;

– Закінчення - поточна (зазначена в розкладі) дата завершення задачі;
– Початок базового плану – дата початку задачі, збережена в базовому плані;

– Закінчення базового плану - дата завершення задачі,
збережена в базовому плані;
– Зсув початку – величина відхилення (за замовчуванням - у днях) дати початку виконання задачі від планової дати (позитивне значення вказує на затримку початку виконання задачі в порівнянні з базовим планом, негативне - на достроковий початок задачі)
– Зсув закінчення – величина відхилення (за замовчуванням - у днях) дата завершення задачі від планової дати; позитивне значення вказує на затримку завершення завдання в порівнянні з базовим планом, негативне - на дострокове завершення задачі.

[image: ]
Рисунок 4.2 – Вартість проекту й базова вартість проекту

Таблиця 4.1 Варіанти завдань

Відсоток (%) виконання проекту ( за часом)
	Вар. 1
	Вар. 2
	Вар. 3
	Вар. 4
	Вар. 5
	Вар. 6
	Вар. 7

	25
	30
	35
	40
	45
	50
	55




[bookmark: _heading=h.3mzq4wv]4.3 Завдання та порядок виконання роботи

4.3.1 Відкрийте проект, створений у попередній лабораторній роботі.
4.3.2 Виконайте введення фактичних параметрів робіт.
[bookmark: bookmark=id.2250f4o]4.3.3 Для однієї із задач проекту введіть фактичні дати початку й закінчення, відмінні від базових.
4.3.4 Проаналізуйте виконання проекту за допомогою методу освоєного обсягу.
4.3.5 Підготуйте звіти, що відображають виконання проекту й відхилення від базового плану проекту.
4.3.6 Переплануйте план проекту відповідно до його поточного стану.
4.3.7 Підготуйте звіт за лабораторної роботи.

[bookmark: _heading=h.haapch]4.4 Контрольні питання

1. Якими параметрами характеризується фактичне виконання робіт, звідки беруть їхні значення, і як ці значення вводяться в проект?
2. Що приводить до відхилення фактичних працезатрат від планових?
3. Яку інформацію про хід проекту одержує менеджер проекту, використовуючи метод освоєного обсягу?
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ДОДАТОК А 
Проектне завдання

1. Назва проекту: Створення офіційного Web-Сайту ТОВ «Компанія»

2. Головна мета проекту – підвищення ефективності роботи компанії.

Мети проекту: підвищення рівня поінформованості потенційних клієнтів про переваги пропонованих послуг; забезпечення зв'язку клієнтів з компанією; залучення уваги клієнтів до найцікавіших пропозицій компанії.
3. Планові строки

початок робіт: 1 вересня 2014 р.
закінчення робіт: 26 грудня 2014 р.
(17 тижнів)

4. Замовник: ТОВ «Компанія»
5. Виконавець: ТОВ «Студент»
6. Склад робіт

Найменування етапів і робіт, їх орієнтовну тривалість представлено в табл. А.1 ( на підставі наявного досвіду виконавця).

	
	Таблиця А.1 – Склад і тривалість робіт проекту
	

	№
	Назва роботи
	Тривалість,

	
	
	день

	
	
	

	1
	Проект
	

	2
	Аналіз вимог
	

	3
	Аналіз предметної області, інтерв'ювання клієнта
	6

	4
	Розробка й затвердження концепту сайту
	2

	5
	Планування проекту
	3

	6
	Складання ТЗ
	5

	7
	Затвердження ТЗ
	2

	8
	Завершення аналізу вимог
	0

	9
	Проектування
	

	10
	Розробка дизайну за затвердженим концептом
	7

	11
	Проектування архітектури сайту
	3

	12
	Проектування БД
	3

	13
	Завершення проектування
	0





	
	Продовження таблиці А.1

	№
	Назва роботи
	Тривалість,

	
	
	день

	14
	Програмування й верстка
	

	15
	Верстка шаблонів сторінок
	32

	16
	Розробка бази даних
	5

	17
	Програмування
	40

	18
	Заповнення сторінок і тестування на реальних даних
	14

	19
	Доробка коду, виправлення помилок
	7

	20
	Завершення програмування й верстки
	0

	21
	Запуск і супровід
	

	22
	Створення пакета передачі
	2

	23
	Підготовка платформи
	1

	24
	Заливання контенту
	1

	25
	Перевірка якості
	3

	26
	Здача сайту замовникові
	1

	27
	Закриття проекту
	1



Розглянемо короткий зміст етапів робіт у їхній технологічній послідовності для визначення зв'язків між задачами.

Аналіз вимог. На даному етапі спочатку здійснюється аналіз предметної області: виявлення потреб майбутніх користувачів; визначення технічних вимог, що включають вимоги до структури сайту, змісту розділів і підрозділів; визначення вимог до дизайну; визначення вимог до структури й функцій програмних модулів; визначення вимог до архітектури, системи керування контентом сайту тощо.

За результатами аналізу складається концепт сайту, який обговорюється із Замовником і командою розробників проекту.

Після затвердження концепту розробники приступають до детального аналізу й формування вимог до розроблюваної системи.

Паралельно з розробкою ТЗ здійснюється планування проекту, що передбачає визначення составу й строків здійснення робіт, ресурсів і бюджету проекту.

Отримані результати приводяться в технічному завданні, яке затверджується Замовником.
Проектування. Дизайн сайту повинен відповідати встановленим цілям і бути функціональним.

Для створення ескізів дизайнер аналізує концепт і технічне завдання.

На даному етапі також проводиться проектування архітектури сайту й проектування бази даних згідно ТЗ.

Програмування й верстка. Верстка шаблонів сторінок здійснюється відповідно до керівництва зі стилю оформлення.

Паралельно з версткою починається розробка бази даних, після чого виконується реалізація спроектованої системи.

Заповнення сторінок контентом і тестування на реальних даних повинні початися за 10 днів до завершення програмування. Роботи з верстки до цього моменту вже повинні бути закінчені.

Доробка коду й виправлення помилок здійснюється відразу по завершенню програмування й наповнення.

Запуск і супровід. До передачі Замовникові й запуску сайту необхідно сформувати комплект документації («пакет передачі»), що включає всі вихідні файли, зображення, шаблони, інструкції та ін., необхідні особі, яка буде супроводжувати сайт після його впровадження.

Одночасно з формуванням пакета передачі проводиться підготовка платформи: розміщення сайту на хостинговому сервері, налаштування й підтримка DNS.

Потім здійснюється перенос сайту (заливання контенту) на сервер Замовника.

Після успішного розміщення на сервері сайт тестується ще раз для усунення помилок, пов'язаних з особливостями розміщення.

Після завершення всіх робіт у встановлений термін з необхідним рівнем якості Замовник підписує акт про впровадження, здійснює взаєморозрахунок з Виконавцем згідно з договором. Керівник здійснює закриття проекту.
7. Планові строки етапів робіт

Планові строки етапів робіт установлювалися на основі аналізу обсягу робіт і наявного досвіду створення аналогічних проектів Виконавцем і наведено в табл. А.2.
Таблиця А.2 – Строки виконання етапів робіт проекту
	№
	Найменування етапу робіт
	Строки виконання
	Тривалість

	1
	Аналіз вимог
	1.09.14-21.09.14
	15

	2
	Проектування
	22.09.14- 30.09.14
	7

	3
	Програмування й верстка
	1.10.14- 17.12.14
	56

	4
	Запуск і супровід
	18.12.14-25.12.14
	6

	5
	Закриття проекту
	26.12.14
	1

	
	Усього
	
	85



8. Трудові ресурси проекту

Список трудових ресурсів, необхідних для виконання проекту, і їх вартість наведені в табл. А.3. Матеріальні ресурси повинні бути сплановані студентами самостійно.

Таблиця А.3 – Список трудових ресурсів
	№
	Назва ресурсу (роль)
	Стандартна ставка грн/година

	1
	Керівник проекту
	40

	2
	Аналітик
	37

	3
	Дизайнер
	30

	4
	Верстальщик
	27

	5
	Програміст Senior
	37

	6
	Програміст Middle
	35

	7
	Програміст Junior
	30

	8
	Тестер, редактор-копірайтер
	25

	9
	Системний адміністратор
	37



8. Орієнтовна вартість етапів робіт

Вартість етапів робіт визначалася за аналогією з реальним проектом створення сайту . Вартість етапів проекту наведена в табл. А.4.

Таблиця А.4 – Вартість етапів робіт
	
	Найменування етапу робіт
	Вартість, тис. грн

	1
	Аналіз вимог
	6

	2
	Проектування
	4

	3
	Програмування й верстка
	37

	4
	Запуск і супровід
	3



9. Бюджет проекту: 50 тис. грн.

10. Матриця задач і відповідальності

Матриця задач і відповідальності встановлює зв'язок між роботами, визначеними в структурі проекту (табл. А.1), і співробітниками (табл. А.3), відображаючи призначення ресурсів на виконання задач (табл. А.5).

Кожній задачі можуть бути призначені декілька співробітників. Ступінь відповідальності співробітників позначена як «О» — основна відповідальність, «В » — допоміжна відповідальність.

Таблиця А.5 – Матриця задач і відповідальності
	Номер
	
	
	
	
	Номер ресурсу
	
	
	

	роботи
	
	
	
	
	
	
	
	
	
	

	
	1
	2
	3
	4
	
	5
	6
	7
	8
	9

	3
	В
	О
	
	
	
	
	
	
	
	

	4
	
	В
	О
	
	
	
	
	
	
	

	5
	О
	
	
	
	
	
	
	
	
	

	6
	В
	О
	
	
	
	
	
	
	
	

	7
	О
	В
	
	
	
	
	
	
	
	

	10
	
	
	О
	
	
	
	
	
	
	

	11
	
	В
	
	
	
	О
	
	
	
	

	12
	
	В
	
	
	
	
	О
	
	
	

	15
	
	
	
	О
	
	
	
	
	
	

	16
	
	
	
	
	
	
	О
	
	
	

	17
	
	
	
	
	
	О
	В
	О
	
	

	18
	
	
	
	
	
	
	
	
	О
	

	19
	
	
	
	
	
	
	
	О
	В
	

	22
	В
	
	
	
	
	О
	
	
	
	

	23
	
	
	
	
	
	
	
	
	
	О

	24
	
	
	
	
	
	В
	
	
	
	О

	25
	
	
	
	
	
	
	О
	В
	
	

	26
	О
	
	
	
	
	
	
	
	
	

	27
	О
	
	
	
	
	
	
	
	
	



                                           
This project has been funded with support from the European Commission. This document reflects the views only of the author, and the Commission cannot be held responsible for any use which may be made of the information contained there in.
Цей проект фінансується за підтримки Європейської Комісії. Цей документ відображає лише погляди автора, і Комісія не несе відповідальності за будь-яке використання інформації, що міститься в документі.
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